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Introduction 
EDGE (Excellence in Design for Greater Efficiencies) is a standard, a green building certification and an online app 
of the International Finance Corporation (IFC). This document is part of a series of documents aimed at the 
global harmonization of the EDGE buildings certification process.  

In these documents, "Must" and "Shall" are used to prescribe obligatory actions. "Can" implies that there is an 
option or ability to do something, but it is not required. Lastly, "May" grants permission or suggests that an 
action is permissible, providing flexibility or discretion to the project team. 

The main target group for this document are EDGE experts, EDGE auditors, EDGE certification providers, and 
anyone interested in learning more about the certification. 

The Part 1 – Building Certification Guidance document serves as a fundamental policy resource, offering 
instructions for certification, an overview of the certification procedure, and information on the types of 
buildings eligible for certification. This key document applies to all projects around the world and shall be used 
as the primary guide throughout the certification process. It is to be used in conjunction with Parts 2 to 6, which 
provide specific guidance on utilizing the EDGE App. 

Table 1 shows the relative position of this document within the set of EDGE user guides. When officially 
released, after the period for public comment, these documents shall replace EDGE User Guide Version 3.0.a. 

Table 1: Position of this document within the EDGE V3 modules. 

Module Overarching Design Energy Water Materials Operations 

App User 
Guides 

Part 1 – 
Building 
Certification 
Guidance 

Part 2 - User 
Guide -  
Design Tab 

Part 3 – User 
Guide - Energy 
Measures 

Part 4 – User 
Guide - Water 
Measures 

Part 5 – User 
Guide - 
Materials 
Measures 

Part 6 – User 
Guide 
Operations 

Building  
Certification 
Guidance 

     

Operations 
Certification 
Guidance 

     

Auditor  
Guidance 

 Part 8 – Auditor Guidance 

Methodology For future release 

Homes 
Prescriptive  
Certification 
Guidance 

Check country-specific documentation 

Note 1: The shaded modules are not applicable. 
Note 2:  All guidance and user guide documents are complimentary information to the EDGE protocol 
documents. 
Note 3: In the case of any discrepancy, the EDGE protocol document takes precedence   

To share feedback with the EDGE team, please send suggestions along with relevant documentation to 
edge@ifc.org.   

mailto:edge@ifc.org
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Glossary 
AHU  Air Handling Unit 

ARI  Air-conditioning and Refrigeration Institute 

ASHRAE American Society of Heating Refrigerating and Air-conditioning Engineers 

BRI  Building Resilience Index 

DNSH  Do Not Significant Harm 

EDGE   Excellence in Design for Greater Efficiencies 

EPI   Energy Performance Index (kWh/m2/year) 

GHG  Greenhouse gas 

GIA  Gross Internal Area 

GWP  Global Warming Potential 

HVAC  Heating, Ventilation and Air-conditioning 

IEC  International Electrotechnical Commission 

I-RECs  International Renewable Energy Certificates 

ISO  International Organization for Standardization 

kW  Kilowatt 

kWh  Kilowatt-hour 

NZEB  Nearly Zero-Energy Building 

PED  Primary Energy Demand 

PUE  Power Use Effectiveness 

RECs  Renewable Energy Certificates 

RICS  The Royal Institution of Chartered Surveyors 

UNFCCC United Nations Framework Convention on Climate Change 

ZC  Zero Carbon 

ZCR   Zero Carbon Renewal 

  



 

© International Finance Corporation 2024. All rights reserved.    EDGE Part 1 – Building Certification Guidance, Pg 5  

Offical Document 

EDGE Certification Guidance 
EDGE certification is a green building certification system that is designed to promote resource-efficient and 
sustainable building practices. EDGE certification focuses on three key areas: energy, water, and embodied 
energy in materials. It provides a framework for evaluating and quantifying the environmental impact of a 
building, considering factors such as energy efficiency, water conservation, and the use of sustainable materials. 

Definitions 
While the definitions described in this section are relevant to the certification guidance, additional definitions 
may be found in the Glossary for the EDGE Governance Protocol document. 

Building 
Defined as a permanent and thermally conditioned construction with at least one full-time equivalent occupant, 
and a primary use that falls with the typologies available in the EDGE App.  At minimum, a building shall include 
water provisions for occupants, lighting systems and a purposely designed thermal conditioning system 
consisting of active technical building systems and/or natural ventilation. All fossil fuels, electricity and water 
used during operations shall be measured or measurable.  

If two buildings are connected by a thermally conditioned space, then they may be considered as a single 
building. Notice that certain components of a building may be physically separated. Examples include a cafeteria 
and individual classrooms of a school that are essential for the functioning of the building. Constructions that do 
not meet the definition of building are not certifiable under EDGE. For questions about specific constructions 
reach out to the EDGE team at edge@ifc.org. 

Building envelope 
It refers to the combined surface area of all components of a building that surround its thermally conditioned 
spaces. These components separate the interior from the external environment and do not include surfaces 
adjacent to other buildings. 

Building footprint 
It refers to the area of ground that a building occupies as defined by its perimeter. 

Building site 
It is defined both the land parcel, and the building(s) situated on it. 

Primary/secondary use 
The main function that the buildings serve, typically described as a typology. A building may have a secondary 
use, i.e. a different typology, which may lead to the need for splitting the building into subprojects. 

Project boundary 
The physical scope of the EDGE certification, including all services required to support the functionality of the 
building, including the area for on-site renewable energy. The project boundary area may be larger than the 
building footprint and building site. 

Project 
Is defined as the building, a group of buildings, an entire residential development, or portfolio submitted for 
EDGE certification with the same certification provider and owner. For example, it may be a residential building 
with two towers, a mixed-use building with offices and retail space, or multiple buildings with the same 
ownership and different locations for the case of a portfolio. The information in the Project section in EDGE is 
the top-level information that applies to all its subprojects. 

mailto:edge@ifc.org
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Subproject 
Refers to the portion of the project modeled individually in EDGE. The information contained in the subproject 
section applies only to the portion being modeled in that file. For example, a subproject may be the residential 
section of a mixed-use tower, the retail space in mixed-use development, or an individual location for a chain of 
stores. 

 

Figure 1. Relationship between project and subprojects. 

If a building has more than one use and the secondary use occupies less than 10% of the floor area up to a 
maximum of 1,000m², the entire building can be certified under the primary use of the building in a single 
subproject. Otherwise, that portion shall be certified separately. For example, if a 10,000m² residential building 
has a retail portion of 1,200m² located within the ground floor, the building areas must be certified separately 
under the Homes and Retail typologies.  

For grouping of multiple buildings into one subproject, refer to the Grouping Multiple Buildings into One 
Subproject, section. 

To achieve certification, 100% of the GIA reported in a subproject must be available for audit. If the building is 
developed in phases, individual subprojects must be created accordingly. 

Unit 
Is an apartment or a home. Units can be defined as single or multiple typologies within the same subproject. 
Refer to Annex 1: Grouping Logic for Residential Units for information grouping units and Annex 3: 
Unfinished/Partially Finished  for minimal conditions and penalty factors.  

 

EDGE Certification 
EDGE certification is awarded if the required minimum efficiencies of 20% are achieved in the three EDGE 
categories — Energy, Water, and Materials. A simple pass/fail system indicates whether the building project has 
demonstrated the minimum 20% savings in operational energy, water and embodied energy in materials 
compared to the base case model. Actual percentage savings for each project can be seen on the EDGE 
certificate as well as in project case studies on the EDGE website. The entire certification process is conducted 
online through the EDGE App, which is managed and maintained by the IFC. 

EDGE certification is a one-time award that does not need to be renewed. Recognition is issued automatically at 
the time of the awarding of a preliminary EDGE certificate and/or final EDGE certification and indicated on the 
EDGE certificate for such a project; it does not require additional documentation or fees. 

EDGE Advanced Certification 
EDGE Advanced status indicates that an EDGE project has achieved 40% or greater savings in Energy, beyond 
the minimum EDGE certification requirements. To meet the requirements for water savings and savings in 
embodied carbon of materials, a minimum of 20% savings over the base case is still necessary. 
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EDGE Zero Carbon Certification 

Definition 
An EDGE Zero Carbon building is defined as one that is committed to resource-efficient operations, maximizes 
on-site renewable energy generation, and responsibly procures offsite energy and carbon offsets, achieving zero 
net GHG emissions. The certification requires organizations to commit to a plan for achieving and maintaining 
net zero carbon operations for their certified buildings. 

The prioritization for achieving a Zero Carbon project is described in Figure 2. Initially, to enhance energy 
efficiency by reducing demand with passive design strategies. Subsequently, design teams need to fulfil the 
remaining energy requirements using efficient building services. The next step is to maximize the generation of 
renewable energy on-site, followed by supplementing with renewable energy generated off-site. Utilizing 
carbon offsets shall be considered a last resource after all other options have been exhausted. 

 

Figure 2: Prioritization of energy efficiency and energy sources to achieve the EDGE Zero Carbon certification. 

Additionally, project teams attempting to achieve Zero Carbon certification must submit an updated GHG 
emissions mitigation plan with short, medium, and long-term absolute emissions reduction targets compliant 
with ISO Net Zero Guidelines - ISO IWA 42:2022 (Chapter 9)1. This plan shall also include a roadmap for: 

▪ Keeping refrigerant emissions below 675 kgCO2e/kg (or any future value for GWP for R-322), 
▪ Phasing out the use of fossil fuels on-site for operational energy (excluding emergency and backup 

systems),  
▪ Maximizing on-site electricity generation within the limits of physical space availability and jurisdictional 

regulations, and,  
▪ Reducing carbon offset credits so that they are less than or equal to the total of the refrigerant mass 

leakage plus 20% of the emissions from imported energy, as defined in ASHRAE Standard 228-2023. 

If project teams can demonstrate compliance with all the above points, they are not required to present a 
roadmap. In such cases, the GHG emissions mitigation plan may be limited to maintaining GHG emissions within 
a specified value. 

Operational Energy Scope 
The operational energy scope corresponds to the B6, and B7 life cycle stages as defined in the RICS’s Whole life 
carbon assessment for the built environment standard. If the building is certified as EDGE Advanced, the scope 
includes the building's energy consumption in accordance with the end-uses defined in the energy tab, including 
process loads within the perimeter boundary. However, the following exceptions may apply in both cases: 

 

1 IWA 42:2022(en) Net Zero Guidelines: https://www.iso.org/obp/ui/#iso:std:iso:iwa:42:ed-1:v1:en 

2 R-32 Refrigerant information for technicians: https://arctick.org/information/r32/  

https://arctick.org/information/r32/
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▪ Energy used for EV charging stations, 
▪ Energy used within internal and external car parks, 
▪ Process loads that are already regulated under IFC-approved emissions trading schemes. 

Eligibility Requirements 
There are three requirements for subprojects to be eligible for EDGE Zero Carbon certification:  

1. The primary use must be among those that are included in the EDGE App:  
a. Residential: Homes & Apartments* 
b. Serviced Apartments  
c. Hotels & Resorts  
d. Hospitals  
e. Industrial  
f. Offices  
g. Education  
h. Retail  
i. Mixed Use  

 
Carbon offsets do not apply for residential buildings and the entire subproject must pursue the EDGE Zero 
Carbon certification, rather than individual units. If the final certification is achieved in phases, the 
subproject may apply for a Preliminary EDGE Zero Carbon certification. 

  
2. A building must have been in operation for at least one year at 75 percent of normal occupancy.  

  
3. A building must be certified as EDGE Advanced or equivalent3.  

 

On-site Energy Requirements 
On-site renewable energy systems must be within the project boundary. Additionally, the building owner must 
either own the renewable energy system, have a lease for them, or have entered a contract to buy the energy 
they produce for a minimum duration of 15 years. 

Offsite Energy Requirements 
The subproject can earn credit for using off-site renewable energy if the renewable energy certificates (RECs) are 

retired. These RECs should be transferred and retired for the subproject, ensuring that the renewable energy is 

not part of the regular grid power. 

If the off-site renewable energy is sourced from a third party, the contract must be for at least 15 years. The 

electricity should be delivered through a local network with enough capacity. 

Examples of off-site renewable energy options include purchased RECs/I-RECs or Power Purchase Agreements 

(PPAs). 

For more details on eligible off-site energy, refer to ASHRAE 228-2023 Informative Appendix B, which outlines 

recommended characteristics for off-site renewable energy procurement. 

 
3 Buildings that meet specific criteria under EDGE for Operations may also qualify for EDGE Zero Carbon certification instead 
of EDGE Advanced certification. For more information, review the corresponding documentation in the EDGE user 
documents. 

https://edgebuildings.com/resources/user-documents/
https://edgebuildings.com/resources/user-documents/
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Carbon Offset Requirements  
Carbon offsets can be procured to compensate for GHG emissions from on-site sources, including fossil fuels and 
refrigerant leakage, as well as any remaining emissions from imported energy.  

If applying carbon offsets, they shall be purchased from a provider that: 

1. Requires the use of a credible methodology, such as:   
▪ Gold Standard  
▪ Verra’s Verified Carbon Standard   
▪ ACR: Carbon Crediting Program for Offsets 
▪ Climate Action Reserve 

Note: ClimateSEED and UNFCCC Clean Development Mechanism (CDM) have been removed from 
the list to align with IFC’s Deal Acceptance Criteria for Carbon Markets. 

2. Adhere to the ten core carbon principles set by the Integrity Council for Voluntary Carbon Markets 
(ICVCM), where applicable, 

3. Favor Independent Carbon Rating Agencies for quality assessment, and 
4. Have a benefit-sharing plan.  

The carbon credits must be from a vintage (year) that is within five years before or after the end date of the 
reporting period.  

RECs that do not qualify as offsite renewable energy due to the unavailability of local REC providers in a 
particular country or jurisdiction may be claimed as carbon offsets for electricity covered within the Operational 
Energy Scope. 

Reporting Timeline 
The EDGE Zero Carbon timeline for first-time certification is presented in Figure 3.  The reporting period must 
include data from the previous 12 consecutive months. The EDGE Zero Carbon certification must start within 6 
months of the last reporting month. 

 

Figure 3. EDGE Zero Carbon timeline for first-time certification. 

For example: If the reporting period is from July 2022 to June 2023 the limit to apply for Zero Carbon 
Certification by December is 2023. 

For Zero Carbon Renewal (ZCR) timeline is presented in Figure 4. The reporting period must cover the entire 
duration of the previous EDGE Zero Carbon certificate. 
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Figure 4: EDGE Zero Carbon Renewal timeline. 

For example: If the previous EDGE Zero Carbon certificate lasted two years, the reporting period shall cover 24 
months.  

Documentation Requirements 
When obtaining EDGE Zero Carbon certification for a project, gather the following information:  

1. Proof of 40 per cent energy savings from the EDGE baseline: Download, save and provide a PDF of the 
certificate for the project from your dashboard in the EDGE App that demonstrates EDGE Advanced 
status or equivalent3. The EDGE Advanced certificate is a one-time assessment of the asset that will not 
need to be provided at the time of recertification unless the building undergoes substantial changes 
such as occupancy changes, a significant addition (more than 10 per cent of the GIA) or a major 
renovation.  

2. Reporting period: The reporting period must follow the guidelines outlined in the Reporting Timeline 
section. 

3. Declaration of occupancy: A signed declaration by the project owner or their authorized representative 
that the project has been occupied at 75 per cent of expected occupancy for the reporting period.  

4. Project area: Building plans showing the GIA – air-conditioned and un -conditioned – of the building, and 
the total GIA for input into the calculator. The GIA does not include balconies and terraces, exterior 
areas or site areas. The EDGE project’s PDF report showing the GIA, and the project file number will be 
sufficient for verification.  

5. Operations Tab – Completed: All energy use information must be entered into the EDGE Operations 
Tab. The data entered in the Operations Tab in the EDGE App must have supporting documentation 
attached.  

6. Energy bills and meter readings: Utility Bills or readings for the reporting period for every source of 
energy used in the building according to the Operational Energy Scope. The bills or meter readings must 
meet the conditions stated in the Reporting Timeline section. Supporting documentation may include 
the following:  

a. Conventional Electricity Bills (kWh)  
b. Onsite Renewable Energy Generated, Consumed and Exported (kWh) – Meter or Building 

Management System Readings.  
c. Offsite Renewable Electricity Bills (kWh). The type of offsite renewable energy (e.g. solar, wind, 

etc.) shall be highlighted.  
d. Bills indicating the quantity of diesel used on site (in Liters)  
e. Bills indicating the quantity of LPG used on site (in kg)  
f. Bills indicating the quantity of natural gas used on site (in m3)  
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7. Purchased offsite energy and/or carbon offsets: Provide proof of procured offsite energy (in kWh) and 
carbon offset certificates or proof of purchase of carbon offsets (in tCO2e) meeting the conditions stated 
in the Reporting Timeline section. 

8. The updated GHG Emissions Mitigation Plan and Roadmap: This plan is detailed in the Definition 
section. During Zero Carbon Renovation, if there are any significant deviations from the original goals, a 
justification must be provided along with an action plan to return to the originally planned timelines. 

Documentation Submission 
All energy use information must be input into the EDGE Operations Tab. Supporting documentation shall be 
uploaded into the EDGE App in the Operations tab.  
 
The documentation is then submitted for verification by the certification provider, who may request additional 
information or evidence within three rounds. During this process, the Updated GHG Emissions Mitigation Plan 
and Roadmap will be reviewed. Any deviations from the original goals must be justified and accompanied by an 
action plan. Failure to provide the requested information or evidence, or unjustified deviations from the 
management plan and roadmap, may result in disqualification from renewal. 

Once the verification process is successfully completed, an EDGE Zero Carbon certificate will be issued. 

Certification Expiration 
The EDGE Zero Carbon certificate will display the year of awarding and expiration according to the following:  

▪ For a project that meets the EDGE Zero Carbon criteria fully on-site, including the generation of on-site 
renewable energy, the certificate will expire after four years.   

▪ For a project that meets the EDGE Zero Carbon criteria by purchasing off-site renewable electricity 
and/or carbon offsets, the certificate will expire after two years.  

▪ The EDGE Zero Carbon certification is rendered invalid when there is a transfer of ownership of the 
building, or the building undergoes significant occupancy changes or substantial changes (as defined in 
the Documentation Requirements, point A). 

Recertification 
A project that has been previously certified as EDGE Zero Carbon can undergo EDGE Zero Carbon Renewal (ZCR) 
to maintain its EDGE Zero Carbon status with the following conditions.  

1. Maintain EDGE Advanced or equivalent3 certification:  
▪ If the building has not had substantial changes (as defined in Documentation Requirements, 

point A) since the last EDGE Zero Carbon certification the project owner or their designated 
representative must provide a signed statement to that effect.  

▪ If the building has had substantial changes (as defined in Documentation Requirements, point 
A), the project team must show that the energy savings of the building are 40 percent in the 
latest version of the EDGE App.  

2. Annual records of performance and updated GHG Emissions Mitigation Plan and Roadmap: The 
project team must submit annual records of information according to the Documentation Requirements 
section, covering the entire duration of the previous Zero Carbon certificate as per the Reporting 
Timeline section. 

3. Submit documentation: The project team must then submit documentation as per the Documentation 
Submission section. 
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Retrofit Projects 
EDGE Zero Carbon retrofit projects follow the same guidelines as those for new construction and existing 
buildings. However, rather than having achieved EDGE Advanced or equivalent3, they have a defined plan to 
reach the necessary energy efficiency levels within a specified timeframe instead. 

A project team working on a retrofit subproject may apply for a Preliminary EDGE Zero Carbon certification 
before achieving post construction EDGE Advanced certificate or equivalent3 under the following conditions:  

▪ The retrofit subproject must demonstrate its work plan on how it will achieve EDGE Advanced or 
equivalent3  when the retrofit is complete, 

▪ If the EDGE Advanced route is chosen, a Preliminary EDGE Advanced certificate must have been 
achieved 

▪ The project owner must provide a signed letter stating that the retrofit measures will be implemented 
within two years of the award of the Preliminary EDGE Zero Carbon certification, and  

▪ The project team must demonstrate the purchase of eligible offsite renewable energy or carbon offsets 
covering operational emissions for the building from the previous 12 consecutive months.  

Note: A GHG Emissions Mitigation Plan and Roadmap is not needed for Preliminary EDGE Zero Carbon 
certification 

When a retrofit project is pending a final (post construction) EDGE Advanced or equivalent3 certificate, the 
Preliminary EDGE Zero Carbon certificate will show that:  

▪ The project is pending upgrades, and   
▪ The certificate is valid for two years.  

By the end of the two-year period, the subproject must have achieved final EDGE Advanced or equivalent3 
certification, offset operational emissions for that period, and created a GHG Emissions Mitigation Plan and 
Roadmap to achieve EDGE Zero Carbon.  

Normative References 
1. International Organization for Standardization. (2022). ISO IWA 42:2022: Net zero guidelines. ISO. 

https://www.iso.org/obp/ui/#iso:std:iso:iwa:42:ed-1:v1:en  
2. Royal Institution of Chartered Surveyors. (2024). Whole life carbon assessment for the built 

environment (p. 94). RICS. Retrieved August 14, 2024, from https://www.rics.org/profession-
standards/rics-standards-and-guidance/sector-standards/construction-standards/whole-life-carbon-
assessment  

3. Verra. (2019). Verified Carbon Standard, VCS Standard Version 4.7. Verra. https://verra.org  
4. Climate Action Reserve. (2021). Reserve Offset Program, Version February 2021. Climate Action Reserve. 

https://www.climateactionreserve.org/  
5. Gold Standard. (2019). Gold Standard, Version 1.2. Gold Standard. https://www.goldstandard.org  
6. American Carbon Registry. (2023). ACR Standard, Version 8.0. Retrieved October 5, 2023, from 

https://acrcarbon.org/ 

 

 

 

https://www.iso.org/obp/ui/#iso:std:iso:iwa:42:ed-1:v1:en
https://www.rics.org/profession-standards/rics-standards-and-guidance/sector-standards/construction-standards/whole-life-carbon-assessment
https://www.rics.org/profession-standards/rics-standards-and-guidance/sector-standards/construction-standards/whole-life-carbon-assessment
https://www.rics.org/profession-standards/rics-standards-and-guidance/sector-standards/construction-standards/whole-life-carbon-assessment
https://verra.org/
https://www.climateactionreserve.org/
https://www.goldstandard.org/
https://acrcarbon.org/
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Project Roles 

Project Team 
In the EDGE certification system, a project owner is the designated individual or representative responsible for 
the entire project. This includes providing project documentation, granting access to the site, and paying audit 
and certification fees. An EDGE Expert is a certified individual proficient in using the EDGE App and 
understanding the certification process; they may be part of the owner's organization or an independent service 
provider. 

The project owner appoints a project team, which may include an EDGE Expert, to demonstrate that the project 
complies with the EDGE standard. The project team achieves this by documenting that the overall project and 
the selected individual measures meet the specifications and minimum performance requirements set by EDGE.  

Four distinct user roles for an EDGE project team are available in the EDGE App to represent the typical 
certification responsibilities.  

1. A Project Owner can assign or remove any user role and create/edit/delete projects in the EDGE App.  
2. A Project Admin is the EDGE Expert or a trained EDGE user who manages the certification flow of the 

project on behalf of the owner.  
3. A Project Editor is typically someone from the design team who can edit the project details and 

documentation.  
4. A Project Viewer can track the project’s progress without the ability to edit. 

 

EDGE Auditors 
EDGE Auditors (henceforth referred to as auditors) are EDGE Experts who have been further accredited to 
conduct project audits for EDGE certification. The role of the auditor is to verify that the design/construction 
team has interpreted the EDGE requirements correctly and that all compliance requirements have been fulfilled. 
Depending on the country and the certification provider, an auditor may be part of the certification provider’s 
team or hired independently. In either case, the project owner is responsible for the auditor fees.  

The auditor reviews the supporting evidence provided by the project team to ensure that it matches the data 
used in the assessment and performs on-site audits. Auditors must be able to verify that 100% the subproject is 
substantially completed for any building type.  

In the case of repetition in design, an auditor must verify the following at a minimum: 

▪ Homes and Apartments   (square root of the number of units) +1, for each unit typology 

▪ Hotels, Resorts, Serviced Apartments (square root of the number of rooms) +1, for each type 

▪ Healthcare     (square root of the number of rooms) +1, for each type 

▪ Retail, Industry, Office, Education  40% of similar areas for a project 

▪ Mixed Use    Each use type to follow the respective rules from above 

▪ Multiple buildings   (square root of the number of buildings) +1 

If the subproject multiplier is above 1, consider: 

▪ For homes and apartments, combine units of the same typology the apply formula above 
▪ For other types, calculate the square root of the number of buildings +1, then apply the formula above 
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EDGE Certification Providers 
EDGE Certification Providers (henceforth referred to as certification providers) are licensed by IFC to operate in 
designated countries. Their role is to oversee auditors and issue the EDGE certificates. Information on contacting 
local certification providers is available on the ‘Certify’ page at www.edgebuildings.com. The project owner is 
responsible for paying the certification fees to the EDGE certification provider. 

 

EDGE Certification Process 
The certification process involves auditing the project documentation submitted by the project team and a site 
audit, followed by the award of the certificate. Requirements for EDGE compliance, at both the preliminary and 
post-construction phases, are specified for each measure in this guide, and include such deliverables as design 
drawings, manufacturers’ data sheets, calculations, proof of delivery and photographs.  

Preliminary Certification: A desktop review of the project is undertaken based on the project’s design 
documentation. For subprojects linked to New Construction and Renovation of Existing Buildings, project teams 
may need to comply with EU taxonomy requirements. In such cases, they may refer to Annex 4: EU Taxonomy 
Technical Alignment. 

Post Construction Certification: A site audit of the project is required for the auditor to verify the installation 
and compliance requirements of all selected measures in EDGE. For subprojects linked to Renovation of Existing 
Buildings and Renovation of Existing Buildings, project teams may need to comply with EU taxonomy 
requirements. In such cases, they may refer to Annex 4: EU Taxonomy Technical Alignment 

All audits shall be directly conducted by an accredited auditor, with certification being awarded by a certification 
provider. 

To begin the certification process, the project owner/EDGE Expert may request a quote from the local 
certification provider via the Certify page on the EDGE buildings website; they may also ‘Express Interest’ via the 
EDGE App to request a quote from the certification provider or local auditor(s). Or a project may choose to 
directly ‘Register’ in the EDGE App. 

 

http://www.edgebuildings.com/
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Figure 5. EDGE Certification Process. 

Documentation Requirements 
Subproject-level documentation is uploaded to the EDGE App. In general terms, the following documents, where 
relevant, are required to demonstrate compliance: 

▪ Design documentation showing (intended) compliance with the requirements of the measure. 
▪ Technical justification of the inputs provided in the design tab that creates the base case. 
▪ A brief explanation of the design drawings, relevant system or product specified/installed. 
▪ Calculations that have been used to assess and demonstrate compliance.  
▪ Manufacturer’s data sheets, with the information required to demonstrate compliance highlighted. 
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▪ Construction Documentation, such as as-built drawings, BOQs and/or photographs that demonstrate the 
construction was as per the design documentation. 

The documentation required for subsections in the design tab can be found in Part 2 - User Guide - Design Tab 

The documentation required for individual measures is included in the Compliance Guidance section of each 
measure in: 

▪ Part 3 – User Guide - Energy Measures 
▪ Part 4 – User Guide - Water Measures 
▪ Part 5 – User Guide - Materials Measures 

The documentation required for the operations tab can be found in the Documentation Requirements sections, 
as part of the EDGE Zero Carbon Certification. 

Non-Typical EDGE Projects 

Special Ruling Request (SRR) 
A Special Ruling Request (SRR) is a mechanism for project teams to request a special ruling on the eligibility of a 
method or measure that has not been included in the EDGE App, to determine compliance with EDGE. This is 
applicable for situations where project teams may want to (1) use an alternative method to comply with the 
intent of an EDGE Measure, or (2) use innovative strategies not included in the available EDGE Measures to 
reduce energy consumption. For example, an SRR would be required for using an alternate tool outside EDGE to 
calculate the Average Annual Shading Factor (AASF) or to calculate the savings from a cooling system type that is 
not available in EDGE.  

The approved SRR report means that a project team has received special permission from IFC’s EDGE Global 
Team to use an out-of-the-norm procedure for claiming measure savings in the EDGE App. Actual compliance 
with the intent of the measure will still be subject to an audit.  

In general, the EDGE User Guides and the Frequently Asked Questions available on the EDGE website serve as a 
starting point for questions related to the EDGE certification. If a project team has gone through the steps above 
and still needs documentation of approval for an atypical approach to its project, it can request a Special Ruling 
Request form from the certification provider.  

An SRR is specific to each project. When the content becomes universally applicable, it will be added to the User 
Guide and no longer require an SRR for compliance. 

Minimum Requirements for an SRR 

▪ The subproject identifier (file number) 
▪ The intended energy improvement per end use in kWh/m2/year,  
▪ The Project team submitting an SRR shall belong to a registered project,  
▪ Be presented in PDF format. 
▪  

Grouping Multiple Buildings into One Subproject 
When buildings are grouped in one subproject but are not identical, project teams may combine GIA, and areas 
of the roof, external walls, and other parts to certify as a single subproject provided that certain conditions are 
met. A single certificate is given for the combined building. When combining buildings, the subproject multiplier 
must be always 1. Combined buildings resulting in a GIA of 50,000m² or above must seek approval from IFC. 

 To group physical buildings into a single subproject, the following criteria must be met: 
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▪ Construction occurs in the same phase, or all buildings are fully constructed 
▪ In commercial buildings, a single entity manages and operates the heating, cooling, ventilation, and hot 

water services. Tenants may use decentralized systems 
▪ The buildings operate on the same days and have similar operating hours, with less than a three-hour 

difference 
▪ Similar HVAC systems are used to condition them 
▪ All users are expected to utilize all the facilities provided regularly 
▪ All buildings shall be of the same sub-typology 
▪ They shall have a standard deviation of up to 2 floors or 10% normalized, whichever is higher. 

 

Buildings being combined shall: 

▪ Use the EEM01 window-to-wall ratio detailed calculator. 
▪ Use the weighted average for the floor-to-floor height and number of floors by area. 
▪ Add up all the building envelope lengths by orientation. 
▪ Add up all the roof areas into one. 

 
Note 1: Each subproject will receive a single certificate (except homes and apartments). 

Note 2: The project team may decide to create separate subprojects even if they meet the conditions above. 
This is especially relevant when more granularity in the EDGE App is required to better assess the impact of 
measures. 

Note 3: Thermally conditioned basements that have a significantly larger footprint (i.e., >10% of building 
footprint) compared to the building tower shall be separated into a different subproject. Partially conditioned 

Example of standard calculation deviation 

Building A: 5 Floors    Building B: 7 floors    Building C: 3 floors 

To calculate standard deviation: 

𝑆𝑡𝑎𝑛𝑑𝑎𝑟𝑑 𝑑𝑒𝑣 (𝑓𝑙𝑜𝑜𝑟𝑠)

=  √
∑(𝑁𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑓𝑙𝑜𝑜𝑟 𝑝𝑒𝑟 𝑏𝑢𝑖𝑙𝑑𝑖𝑛𝑔 −  𝑎𝑣𝑒𝑟𝑎𝑔𝑒 𝑓𝑙𝑜𝑜𝑟𝑠)2

𝑁𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑏𝑢𝑖𝑙𝑑𝑖𝑛𝑔𝑠

= √
8

3
= 𝟏. 𝟔𝟑 𝒇𝒍𝒐𝒐𝒓𝒔. 

To calculate the normalized standard deviation: 

𝑁𝑜𝑟𝑚𝑎𝑙𝑖𝑧𝑒𝑑 𝑆𝑡𝑎𝑛𝑑𝑎𝑟𝑑 𝑑𝑒𝑣 (%)

=
𝑆𝑡𝑎𝑛𝑑𝑎𝑟𝑑 𝑑𝑒𝑣 (𝑓𝑙𝑜𝑜𝑟𝑠)

 𝑎𝑣𝑒𝑟𝑎𝑔𝑒 𝑓𝑙𝑜𝑜𝑟𝑠
 𝑥 100%

=  
1.63

5
 𝑥 100% = 𝟑𝟑. 𝟕%  

This means building A, B and C cannot be grouped into a subproject 

due to Normalized Standard Deviation being >10%. 
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basements that have >10% of the building footprint, with the conditioned space within the building footprint, 
will not be required to have a separate subproject. 

Existing Building and Retrofit Projects 
Existing buildings may apply for EDGE certification. The same standards for energy and water apply to existing 
buildings as for new construction.  

Existing building and retrofit projects that do not have details on the building element construction shall use the 
thickness of the wall and provide a calculation using the default base case, e.g. brick walls with no insulation. 
The same applies same for roofs and other passive elements. 

Materials in existing buildings that are being kept in the building or re-used and are older than five years may be 
claimed as “re-used.” (This applies to re-use of materials older than five years in new construction as well). To 
claim a building as existing and/or to claim re-use of materials, the project team must provide documentation 
from the formal local source that shows the date when the building was constructed or last modified. For 
example, the formal source in a location may be a building department and the documents may be drawings 
stamped by the building department. Pictures of the existing building and materials shall also be provided as 
evidence.  

Note: Existing buildings and Retrofit projects have the same calculation methodology in the EDGE app. 

Reporting Equipment Loads from Existing Buildings 
For existing buildings and major renovations that are currently in operation, it is highly recommended to report 

equipment and plug loads, as shown in Figure 6, in line with the Operational Energy Scope. This practice helps to 

reduce discrepancies between the expected and the actual loads. By doing so, the predictive accuracy of the 

EDGE App is enhanced, leading to better-informed decision-making.   

 

Figure 6: Plug and Equipment Loads in the Detailed Loads Input. 

Note: For detailed information on each of the columns editable by the project teams, consult Part 2 - User Guide 
-Design Tab – Area & Loads Breakdown - Detail Load Inputs. 

To report equipment and plug loads, the project team shall follow these steps: 

1. Inventory Equipment: Create a detailed inventory of all equipment in the building that consumes 
energy, including appliances, office equipment, and any specialty equipment. 
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2. Record Specifications: For each piece of equipment, record detailed specifications such as make, model, 
power rating (watts or kilowatts), and operational schedules. This information can often be found on the 
equipment nameplate or in the manufacturer's documentation. If the number of equipment units is 
large (e.g. > 50 pumps), Part 2 - User Guide -Design Tab, Annex 1: Sampling Methodology may be used. 

3. Calculate Loads: Use the recorded power ratings to calculate the load of each piece of equipment. For 
variable loads or equipment that cycles on and off, estimate the average load based on typical usage 
patterns. 

4. Summarize Data: Organize the equipment loads in a spreadsheet, categorizing them by type and 
including subtotals for each category. 

5. Apply Diversity Factors: Not all equipment will operate at full capacity simultaneously. Apply diversity 
factors to account for such variation in use. If this value is not known, assume 0.5. 

6. Calculate electricity use by area: Divide the resulting loads (in Watts) by the corresponding space area 
(m2). Provide such value in the corresponding column (Plug Loads or Equipment Loads) in the Detailed 
Loads Input. 

The plug and equipment load report shall be attached as part of the documentation in the Design tab section, if 
applicable. 

For the case of Kitchen and & Food Prep Loads, shown in  Figure 7, good practices for documenting information 
include: 

▪ Building surveys of current occupants, observing Part 2 - User Guide -Design Tab, Annex 1: Sampling 
Methodology requirements, 

▪ Direct evidence from energy meters, sensors, or other measurements, 
▪ A narrative justification of the consumption patterns that aligns with the actual kitchen facilities in the 

project. 

 

Figure 7: EDGE Kitchen & Food Preparation data. 

Note: For detailed information on each of the columns editable by the project teams, consult Part 2 - User Guide 
-Design Tab – Area & Loads Breakdown - Kitchen & Food Prep Loads Inputs. 
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Core & Shell Subprojects 
Core and Shell are commercial and/or industrial subprojects where the owner is responsible for the building 
exterior (“shell”) and the core facilities (“core”), but the interior areas are constructed by the tenants (“fit out”). 
The owner or developer must certify the entire space they own/develop. Besides, the total energy used by the 
tenant, as defined in the Operational Energy Scope, must be estimated based on the likely primary use of the 
entire lettable space. Additional requirements may apply for Industrial Buildings. 

For Core and Shell subprojects, the measures for which the tenants are responsible can also be claimed in line 
with Annex 2: Core & Shell Measures.  

In commercial buildings, this is allowed only if a “tenant fit-out guide” is included in the lease agreement and 
signed between the tenants and owners. This tenant fit-out guide must define the requirements to be fulfilled 
by the tenants for the measure and be included in the EDGE submission. If some of the tenants have not signed 
a lease at the time of EDGE certification, the building owner must show EDGE compliance by providing the 
template of the lease agreement accompanied by a signed letter stating that the tenant fit-out guide in the 
template lease agreement will be included in all tenant lease agreements signed for the building.  

For example, if an office building for lease is not fitted with lighting fixtures for tenants and there is no provision 
for efficient lighting in a binding lease agreement or similar provision, then this measure cannot be claimed for 
those spaces.  

Savings that can be passed to home owners in residential subprojects are found in the Annex 3: 
Unfinished/Partially Finished Residential Buildings section. 

 

Minimum Water Fixtures for Residential Units 
To be certifiable, all units in residential subprojects must include at least one installed fixture for: 

▪ WEM01 Water-efficient Showerheads 
▪ WEM02 Water-efficient Faucets for Bathrooms 
▪ WEM04 Efficient Water Closets for Bathrooms 
▪ WEM08 Water-efficient Faucets for Kitchen Sinks 

A penalty factor will be applied based on the percentage of fixtures per measure that are not installed in the 
entire subproject. Details are as follows: 

▪ Mandatory Installation: All units in residential subprojects must include at least one installed fixture for 
each of the water measures listed above to be certifiable. See the definition below of installed fixture. 

▪ Installed Fixture Definition: A fixture that is audited and ready for occupant use. For fixtures claiming hot 
water, the auditor must verify that the fixture can deliver hot water at the design supply 
temperature. Fixtures not considered installed are assumed to have a base case flow and count toward 
the penalty factor. 

▪ Flow Restrictors: These can only be used once the mandatory installation requirement has been met. 
After that, audited water outlets with flow restrictors are considered installed and may claim savings. 

▪ Penalty Factor: This factor is applied to the flowrates for each measure in the subproject before it is 
reported in the EDGE App as the improved case. The penalty factor varies according to the percentage of 
fixtures per measure that are not installed in the entire subproject, as shown in Table 2. 
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Table 2: Base case penalty value for Water Fixtures that are not included in home units. 

% of fixtures not installed Base Case Penalty Factor 

0 < current % ≤ 10 1.1 

10 < current % ≤ 20 1.15 

20 < current % ≤ 30 1.20 

30 < current % ≤ 40 1.28 

40 < current % ≤ 50 1.38 

current % > 50 1.53 

 

 To calculate the value that will be entered in the EDGE App, it is first required to calculate the Weighted 
Average Improved Case (𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝐴𝑣𝑒𝑟𝑎𝑔𝑒𝐼𝑚𝑝𝑟𝑜𝑣𝑒𝑑 𝐶𝑎𝑠𝑒): 

𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝐴𝑣𝑒𝑟𝑎𝑔𝑒𝐼𝑚𝑝𝑟𝑜𝑣𝑒𝑑 𝐶𝑎𝑠𝑒  (
𝑙

𝑠
)  

=
(𝑁𝑛𝑜𝑛 𝑖𝑛𝑠𝑡𝑎𝑙𝑙𝑒𝑑 𝑓𝑖𝑥𝑡𝑢𝑟𝑒𝑠 ∗  𝐹𝑙𝑜𝑤 𝑅𝑎𝑡𝑒𝐵𝑎𝑠𝑒 𝐶𝑎𝑠𝑒) + (𝑁𝑖𝑛𝑠𝑡𝑎𝑙𝑙𝑒𝑑 𝑓𝑖𝑥𝑡𝑢𝑟𝑒 ∗ 𝐹𝑙𝑜𝑤 𝑅𝑎𝑡𝑒𝐼𝑚𝑝𝑟𝑜𝑣𝑒𝑑 𝐶𝑎𝑠𝑒) 

(𝑁𝑛𝑜𝑛 𝑖𝑛𝑠𝑡𝑎𝑙𝑙𝑒𝑑 𝑓𝑖𝑥𝑡𝑢𝑟𝑒𝑠 + 𝑁𝑖𝑛𝑠𝑡𝑎𝑙𝑙𝑒𝑑 𝑓𝑖𝑥𝑡𝑢𝑟𝑒)
 

 

  And then multiply the 𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝐴𝑣𝑒𝑟𝑎𝑔𝑒𝐼𝑚𝑝𝑟𝑜𝑣𝑒𝑑 𝐶𝑎𝑠𝑒 by the 𝑃𝑒𝑛𝑎𝑙𝑡𝑦 𝐹𝑎𝑐𝑡𝑜𝑟, obtained from Table 2: 

  𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝑎𝑣𝑒𝑟𝑎𝑔𝑒𝐼𝑚𝑝𝑟𝑜𝑣𝑒𝑑 𝑐𝑎𝑠𝑒 𝑓𝑖𝑛𝑎𝑙 (
𝑙

𝑠
) = 𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝐴𝑣𝑒𝑟𝑎𝑔𝑒𝐼𝑚𝑝𝑟𝑜𝑣𝑒𝑑 𝐶𝑎𝑠𝑒  (

𝑙

𝑠
) ∗ 𝑃𝑒𝑛𝑎𝑙𝑡𝑦 𝐹𝑎𝑐𝑡𝑜𝑟  

Example: WEM01 Water-efficient Showerheads 

Consider the following subproject, which includes three units. Each unit contains three shower fixtures, 
making a total of nine fixtures. Out of these, six fixtures have been installed (indicated in blue), while 
three fixtures have not been installed (indicated in red). 

 

Step-by-step calculations: 

Table 3: Example of base and improved case flowrates. Note that 33% of the fixtures for the entire subproject have not been 
installed, leading to a penalty factor of 1.28. 

Case Flow Rate (l/s) Number of fixtures 

Base 9.50 3 

Improved 4.70 6 
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1. Calculate the weighted average improved case 

𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝐴𝑣𝑒𝑟𝑎𝑔𝑒𝐼𝑚𝑝𝑟𝑜𝑣𝑒𝑑 𝐶𝑎𝑠𝑒  (
𝑙

𝑠
)  =

(3 ∗  9.50) +  (6 ∗ 4.70) 

(3 +  6)
 

𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝐴𝑣𝑒𝑟𝑎𝑔𝑒𝐼𝑚𝑝𝑟𝑜𝑣𝑒𝑑 𝐶𝑎𝑠𝑒  (
𝑙

𝑠
)  = 6.30 

2. Find the improved case flowrate with a penalty factor of 1.28, corresponding to 33% of non-installed 
fixtures. 

𝐼𝑚𝑝𝑟𝑜𝑣𝑒𝑑 𝑐𝑎𝑠𝑒 (
𝑙

𝑠
) = 6.30 ∗ 1.28 

𝐼𝑚𝑝𝑟𝑜𝑣𝑒𝑑 𝑐𝑎𝑠𝑒 (
𝑙

𝑠
) = 8.06 

Partial Building Subprojects 
A part of a commercial or industrial building may apply for EDGE certification. Residential buildings cannot apply 
for partial building projects. Partial building projects may be either owner led, or tenant led:  

▪ For owner-led certification, the owner must certify all areas within the building that are under the same 
ownership. The energy required for common amenities, shared services, outdoor, exterior areas and 
parking must be proportionally assigned (e.g. by floor area) to the owner. 

▪ For tenant-led certification, the tenant must certify all areas that are part of their lease agreement. 
Certification of the tenanted area shall expire upon the departure of the tenant from the certified area. 
Additionally, the energy for thermal conditioning of the building must be included, even in the scenario 
where a centralized HVAC system is present. The energy required for common amenities, shared 
services, outdoor, exterior areas and parking may be excluded. 

The certification of partial building subprojects must: 

▪ Meet the definition of Building, 
▪ Be fully sub-metered for electricity, with additional fuels also being measurable in line with the 

Operational Energy Scope, 
▪ Be capable of having an independent user schedule separate from other spaces, and 

Be physically defined by a permanent barrier, such as interior and/or exterior walls. 

For partial building projects, the following entries must be made in the EDGE App, as applicable: 

▪ For the building envelope, the external wall lengths, materials, and Window-to-Wall Ratio (WWR) should 
reflect the actual space applying for certification. 

▪ Subtract the portion of a building's wall that is not exposed to the exterior. 
▪ Enter the ceiling area as the roof area. If there are permanently conditioned floors above the project, 

input a U-value of 0.01 W/m2K in EEM05 Insulation of Roof. If the project is on the topmost floor, enter 
the actual U-value of the roof in EEM05 Insulation of Roof. 

▪ If the space under the floor is permanently conditioned, use a U-value of 0.01 W/m2K for EEM06 
Insulation of Ground/Raised Floor Slab. If the certification area is on the bottom floor, use the known U-
value for the bottom floor; if unknown, use the base case U-value. 

▪ Bathroom fixtures and fittings may not be within the building but could be within the project boundary. 
In this case, the project team must obtain water consumption data (liters per flush, flow rates) for all 
shared facilities. If water fixtures specifications are not available, onsite measurements are required.  
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Industrial Buildings 
Unlike most building typologies, for industrial buildings there is no assumption of business as usual related to 
process loads, i.e. equipment and plug gains. The project team shall actively document each of the relevant 
loads and provide them to the EDGE app in line with the Operational Energy Scope. 

In order of importance, project teams shall either: 

1. Provide an equipment schedule following steps in Reporting Equipment Loads from Existing Buildings 
section, where buildings are fully operational at the time of the certification, if this option is not 
possible, then, 

2. Calculate the process loads by estimating equipment gains for similar industrial subtypes (usage) in the 
region and/or the client’s own portfolios; or 

3. Assume:  
▪ For the warehouse subtypology, 35% of the GIA as cold storage area. 
▪ For the light industry subtypology, 70% of the equipment loads contribute to the total energy 

consumption of the base case scenario (i.e., prior to the implementation of on-site renewable 
energy sources). 

Portfolio Projects 
To standardize audits and reduce documentation review efforts, project teams may choose to apply for portfolio 
projects when buildings with shared ownership are expected to be certified within a similar timeframe. These 
buildings can be grouped together based on the following characteristics: 

▪ Age of the building 
▪ Jurisdiction, typically referring to the country 
▪ Climate zone, such as whether the area is cooling or heating dominated 
▪ Building fabric performance, including aspects like building envelope and glazing specifications 
▪ Technical building systems performance, such as HVAC efficiencies and distribution systems 
▪ The type of EDGE efficiency measures claimed. 

Note: Portfolio clustering excludes residential typologies (i.e., Homes & Apartments) 

If this is the case, the process for portfolio certification is indicated in Figure 8. 

 

Figure 8:Portfolio certification step-by-step process. 
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Step-by-step process 

1. Registration: 
a. The project team submits a list of all portfolio buildings intended for certification to the 

certification provider. 
b. The project team informs the certification provider of the selected auditor.  
c. Note: This 'registration' does not refer to the registration of projects in the EDGE App. It involves 

submitting a list of buildings to the certification provider, as not all buildings will be created on 
the EDGE App simultaneously. 

2. Cluster Definition: 
a. The project team divides all portfolio buildings intended for certification into clusters of 

buildings with similar characteristics, following the Annex 5: Portfolio Clustering Workflow. 
3. Sample Selection: 

a. The auditor selects a representative sample of buildings to be audited. For relatively 
homogeneous buildings, 10% of the buildings per cluster, selected at random, shall be audited. 
Exceptions apply. 

4. Sample Building Assessment Creation: 
a. The project team creates EDGE assessments for each sample building (as selected by the auditor 

in the previous step) in the EDGE App, uploading documentation for the Design Tab and each 
measure claimed, in line with the guidelines. 

b. The certification provider assigns the appointed auditor to the relevant subprojects in the EDGE 
App. 

c. The project team submits samples to the auditor on the EDGE App for audit. 
5. Design/Site Audits 

a. The auditor performs design/site audits for sample buildings. 
b. The auditor checks that all samples have the same measure selection. 

6. Sample Certification Review  
a. If the auditor finds no obvious non-conformities or non-compliances during the audit, the 

auditor submits the sample buildings for certification provider review on the EDGE App. 
b. The certification provider completes a review of each sample building in the EDGE App. 
c. Note: If one sample building in the cluster fails to achieve certification, other sample buildings 

that pass the EDGE standard can still be awarded certification, but all non-sampled buildings in 
that cluster will fail to achieve certification. 

7. Non-Sample Roll Out  
a. The certification provider confirms that all sample buildings in the same cluster have been 

approved and that measures are consistent between them. 
b. The certification provider selects the building with the worst specifications as the template 

building for non-sample creation. 
c. The certification provider requests the Client to create non-sampled building assessments based 

on the template assessment.  
d. The project team creates non-sample assessments in the EDGE App, using the Save As function 

With Documents, modifying only the Design Tab input and EEM01 Window-to-Wall Ratio. 
e. The project team notifies the certification provider through email when assessments have been 

created according to the initial list of buildings registered with the certification provider, without 
submitting for audit on the App. (Status on app: “Project Registered”) 

f. Note: In this process, all non-samples will use the same documentation and have the same input 
on all selected measures as the template assessment. This might not reflect the actual 
performance of each building.  
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8. Non-Sample Certification Review  
a. The certification provider reviews updated sections of the non-sample assessments in the EDGE 

App. 
b. Note 1: This non-sample certification process does not involve any changes in certification status 

on the EDGE App, assessments on the EDGE App are not locked for review, and auditors do not 
perform any audits.  

c. Note 2: If a non-sample building fails to achieve the standard required for certification, then that 
non-sample will not be certified with this cluster. It can, however, be re-registered and certified 
in the future with a new batch of buildings. 

9. Certification Decision  
a. Following the complete review of the cluster, the certification provider issues electronic 

certificates in the EDGE App for each approved building, using the Certify through Reference 
function. 

 

Data Centers 
EDGE offers project teams the opportunity to certify data centers as green, although this certification is currently 
in the pilot phase. Any data center worldwide, whether new or existing, is eligible to apply. To be eligible for 
EDGE certification, data centers must meet the following three requirements: 

1. The primary purpose of the building must be to serve as a data center. 
2. The data center must achieve a minimum of 20 percent savings in water and embodied energy in 

materials, according to the EDGE standard.  
3. The Power Usage Effectiveness (PUE) of the data center must be at least 20% better than the baseline 

PUE. PUE is calculated as follows: 

𝑃𝑈𝐸 =  
𝑇𝑜𝑡𝑎𝑙 𝑎𝑛𝑛𝑢𝑎𝑙 𝑒𝑛𝑒𝑟𝑔𝑦 𝑒𝑛𝑡𝑒𝑟𝑖𝑛𝑔 𝑡ℎ𝑒 𝑑𝑎𝑡𝑎 𝑐𝑒𝑛𝑡𝑒𝑟 𝑚𝑒𝑎𝑠𝑢𝑟𝑒𝑑 𝑎𝑡 𝑖𝑡𝑠 𝑏𝑜𝑢𝑛𝑑𝑎𝑟𝑦 

𝐴𝑛𝑛𝑢𝑎𝑙 𝑒𝑛𝑒𝑟𝑔𝑦 𝑢𝑠𝑒𝑑 𝑏𝑦 𝑡ℎ𝑒 𝐼𝑇 𝑒𝑞𝑢𝑖𝑝𝑚𝑒𝑛𝑡 𝑖𝑛𝑠𝑖𝑑𝑒 𝑡ℎ𝑒 𝑑𝑎𝑡𝑎𝑐𝑒𝑛𝑡𝑒𝑟
 

EDGE utilizes the PUE (power usage effectiveness) as the energy baseline for data centers. PUE is a metric 
defined by The Green Grid that describes how efficiently a data center uses energy. It is a ratio of the total 
amount of energy used by a facility to the energy delivered to IT equipment.  

The baseline PUE values used in EDGE are shown in Table 4. These values are subject to change after the pilot 
phase.  

Table 4: Baseline and Target PUE per Climate Type. 

Climate Type Baseline 
PUE 

Target PUE for 
EDGE Certified (20% 

improved) 

Target PUE for EDGE 
Advanced (40% improved) 

Target PUE for EDGE Zero 
Carbon Certification 

Hot & Humid Climate 
(ASHRAE Climate 
Zones 1A, 2A, 3A) 

1.95 1.56 1.17 
(1.36 excluding offsite 

renewable energy) 

1.17 
(1.36 excluding offsite 

renewable energy) 

Other Climate Zones 1.81 1.45 1.09 
(1.27 excluding offsite 

renewable energy) 

1.09 
(1.27 excluding offsite 

renewable energy) 

 

Data centers with at least 20% improvement in PUE will achieve EDGE Certified status and data centers with at 
least 40% improvement in PUE will achieve EDGE Advanced status. 

https://www.thegreengrid.org/
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Certification Guidance 
Project teams shall follow the following guidelines to show compliance with the EDGE standard: 

A. The project team shall model the data center as a subproject under the Mixed Use typology. 
B. Under the Design tab, the area designated as data center shall use the area of the same name, Figure 9. 

Other areas must be modelled to cover the entire Gross Internal Area (GIA) of the building. 

 

Figure 9: Data centers subprojects shall report the entire GIA of the building using the corresponding areas. 

C. Under the Design tab modify the detail loads input calculator to reflect the IT equipment load as close as 
possible to the PUE report results. 

D. The project team shall calculate the total PUE Category 2 as defined by ISO/IEC 30134-2:2016 
Information technology — Data centers — Key performance indicators — Part 2: Power usage 
effectiveness (PUE).  

a. Readings must be made as total kWh over a 12-month period. 
b. All fuel types serving the data center must be converted to equivalent kWh. 

E. The PUE may include renewable energy. 𝑃𝑈𝐸𝑜𝑛𝑠𝑖𝑡𝑒 𝑅𝐸, which includes onsite renewable energy, shall be 
calculated with the following equation for onsite renewable energy:  
 
 

𝑃𝑈𝐸𝑜𝑛𝑠𝑖𝑡𝑒 𝑅𝐸 =
𝑇𝑜𝑡𝑎𝑙 𝑎𝑛𝑛𝑢𝑎𝑙 𝑒𝑛𝑒𝑟𝑔𝑦 𝑒𝑛𝑡𝑒𝑟𝑖𝑛𝑔 𝑡ℎ𝑒 𝑑𝑎𝑡𝑎 𝑐𝑒𝑛𝑡𝑒𝑟 − 𝑎𝑛𝑛𝑢𝑎𝑙 𝑜𝑛𝑠𝑖𝑡𝑒 𝑟𝑒𝑛𝑒𝑤𝑎𝑏𝑙𝑒 𝑒𝑛𝑒𝑟𝑔𝑦 𝑝𝑟𝑜𝑑𝑢𝑐𝑡𝑖𝑜𝑛

𝐴𝑛𝑛𝑢𝑎𝑙 𝑒𝑛𝑒𝑟𝑔𝑦 𝑢𝑠𝑒𝑑 𝑏𝑦 𝐼𝑇 𝑒𝑞𝑢𝑖𝑝𝑚𝑒𝑛𝑡 𝑖𝑛𝑠𝑖𝑑𝑒 𝑡ℎ𝑒 𝑑𝑎𝑡𝑎 𝑐𝑒𝑛𝑡𝑒𝑟
 

 
F. If applicable, PUERE, which includes renewable energy, shall be calculated with the following equation 

for onsite and eligible offsite renewable energy:  
 

𝑃𝑈𝐸𝑅𝐸 =  
𝑇𝑜𝑡𝑎𝑙 𝑎𝑛𝑛𝑢𝑎𝑙 𝑒𝑛𝑒𝑟𝑔𝑦 𝑒𝑛𝑡𝑒𝑟𝑖𝑛𝑔 𝑡ℎ𝑒 𝑑𝑎𝑡𝑎 𝑐𝑒𝑛𝑡𝑒𝑟 − 𝑎𝑛𝑛𝑢𝑎𝑙 𝑜𝑛𝑠𝑖𝑡𝑒 𝑟𝑒𝑛𝑒𝑤𝑎𝑏𝑙𝑒 𝑒𝑛𝑒𝑟𝑔𝑦 − 𝑎𝑛𝑛𝑢𝑎𝑙 𝑜𝑓𝑓𝑠𝑖𝑡𝑒 𝑟𝑒𝑛𝑒𝑤𝑎𝑏𝑙𝑒 𝑒𝑛𝑒𝑟𝑔𝑦

𝐴𝑛𝑛𝑢𝑎𝑙 𝑒𝑛𝑒𝑟𝑔𝑦 𝑢𝑠𝑒𝑑 𝑏𝑦 𝐼𝑇 𝑒𝑞𝑢𝑖𝑝𝑚𝑒𝑛𝑡 𝑖𝑛𝑠𝑖𝑑𝑒 𝑡ℎ𝑒 𝑑𝑎𝑡𝑎 𝑐𝑒𝑛𝑡𝑒𝑟
 

 
Eligible offsite renewable energy, as per Offsite Energy Requirements section, can count toward 
contribution to PUE only for EDGE Advanced and EDGE Zero Carbon  certification for a maximum of 10% 
with respect to the PUE baseline, see Table 4. 

G. The following steps must be followed in the Energy, Water and Measure tabs: 
a. Complete the mandatory measures in the Energy tab to accurately represent the actual 

conditions of the building, as outlined in Part 3 – User Guide - Energy Measures. 
b. Calculate the percentage improvement in PUE compared to the baseline. The savings are 

calculated as follows: 

𝑂𝑣𝑒𝑟𝑎𝑙𝑙 𝐸𝑛𝑒𝑟𝑔𝑦 𝑆𝑎𝑣𝑖𝑛𝑔𝑠 (%) = 1 −
𝑃𝑈𝐸𝑅𝐸

𝑃𝑈𝐸 𝑏𝑎𝑠𝑒𝑙𝑖𝑛𝑒
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c. If applicable, enable EEM33 – Onsite Renewable Energy to reflect the percentage of onsite 
renewable electricity. Note that this measure impacts both energy savings and operational 
emissions. 

d. Enable EEM34 – Other Energy Saving to match the overall energy savings.  
e. If applicable, select EEM35 – Offsite Renewable Energy Procurement to reflect the percentage of 

eligible offsite renewable electricity. Note that this measure impacts only operational emissions, 
not energy savings. 

f. Complete the at least mandatory Water Measures tab as you would for any other project. Water 
required for cooling may be excluded from the water calculation unless otherwise specified by 
IFC. 

g. Complete the Material Measures tab as you would for any other project. Refer to Part 5 – User 
Guide - Material Measures for special considerations regarding miscellaneous structural loads. 

H. Upload evidence and external calculations in the measure documentation of all selected measures. 
I. The project’s auditor shall send the PUE report to IFC (edge@ifc.org) for review and approval before 

recommending the project for certification. 

Documentation Submission 
A. Energy Measures Preliminary Documentation: The approved PUE report approved by IFC, which shall 

include details of all the inputs and assumptions that were used in the simulation: 
a. Weather file  
b. Building construction and fenestration details (U-values, SRI, WWR, etc.) 
c. Lighting power densities 
d. Occupancy, lighting, and equipment profiles 
e. Indoor temperature and humidity set points 
f. HVAC systems details (capacity, efficiency, part load performance etc.) 

B. Energy Measures Post Construction Documentation: Including, where applicable: 
a. The updated PUE report. 
b. As-built drawings showing envelope and fenestration details and calculations of: 

i. Glass: U-value (W/m2 K), SHGC, VT(Factor). 
ii. Floors: U-value (W/m2 K), Weighted Average U-value (W/m2 K), if applicable 

iii. Roofs: Roof Assembly U-value (W/m2 K), Weighted Average Roof U-value (W/m2 K), if 
applicable 

iv. Exterior Walls: U-value (W/m2 K), Weighted Average Roof U-value (W/m2 K), if 
applicable 

v. Window-to-wall ratio: Average WWR (%) 
c. As-built drawings and data sheet showing room loads per areas, include occupancy and lighting 

power density assumptions. 
d. Final load schedule showing, including (when applicable): model, quantities, power input, 

electrical characteristics, capacity, location, COP. Examples of equipment include: 
i. FCUs 

ii. Make up air units 
iii. Air handling units 
iv. Air conditioning units 
v. Chillers 

vi. Water pumps 
vii. Chilled water coils 

viii. Fans and blowers 
ix. Fuel oil bulk storage tank 

mailto:edge@ifc.org
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x. Air separator 
xi. Expansion tank 

e. As-built PUE calculation table showing: 
i. Annual energy used by the IT equipment inside the datacenter (kWh). Proof that it is the 

same as the total IT demand load calculated for capacity planning. 
ii. The annual facility loads calculation (kWh). Include a facility load breakdown, for 

example: 
1. Lighting 
2. Cooling system (e.g., SPLCs) 
3. Chillers 
4. Chilled water pumps 
5. Condenser water pumps 
6. Coil/Fan Walls 
7. AHUs/FCUs/CUs 
8. Fans 
9. PDUs and transformers 
10. Transformers 
11. General losses (transformer, distribution, generator, UPS, switches, etc.) 

C. Water and Materials: The documentation of water and material measures are documented any other 
project, as specified in Part 4 – User Guide - Water Measures and Part 5 – User Guide - Material 
Measures guidance. 
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Navigating the EDGE App 
 

The EDGE App is designed with a simple, user-friendly interface. This section highlights a few key features. 

The EDGE App loads in the Homes typology by default. A user can select a different typology from the sidebar on 
the left as shown in Figure 10, or from the drop down menu in the first panel. From the top right options, a user 
can view their user dashboard, change the version and language, and sign in. 

 

Figure 10. Screenshot showing the primary layout of the EDGE App 

Figure 11 shows the main tabs — Design, Energy, Water and Materials. Above the tabs is the Results bar. Some 
panels on the Design tab, and all Measures, have an Options menu. The Options menu can provide several 
functions depending on the panel, such as Detailed Inputs, Calculators, or Document Upload. 

 

Figure 11. Screenshot of the EDGE App showing key features – the Main Pages or Tabs, Results Bar, and the Options Menu 
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Default Values and User Entries 
The EDGE App is designed with default input values for all fields so that users can model the buildings with 
minimal inputs.  

However, users must note that the EDGE App will use the default values unless a user overwrites them. 
Therefore, attention must be paid to the default values, especially during the certification process, to confirm 
that the assumptions reflect the actual building. 

 

Figure 12. An example of default values and user entries in the EDGE App 

 

Tip: Underlined field names in EDGE are editable.  

 

Clicking on the field name displays the input field. 

 

Figure 13. Most fields in the EDGE App are editable. 

 
Similarly, most efficiency measures are editable. However, their availability may vary per building typology. 

Selecting a measure displays the possible inputs. The value associated with a measure gets overwritten by the 
user input. For example, in the measure EEM01 Window-to-Wall Ratio in Figure 14, a user can overwrite the 
value 16% with the actual value in the project. Some measures will have a calculator. If this is present, you may 
edit it by clicking the three dots on the right side of the box, and then selecting “calculator”. Project teams shall 
utilize the calculators where applicable. 
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Figure 14. Most measures in the EDGE App are editable. 

 

Required Measures  
In EDGE, an asterisk (*) next to a measure indicates that the project team is required to enter the actual 
specifications of the measure in EDGE if that measure is present in the project.  

The indication of a “required” measure in EDGE does not mean that EDGE requires that the measure must be 
implemented in the project, or that the improved case must meet or exceed the baseline case to comply with 
EDGE requirements. 

For example, if a residential project needs to report glazing material, the measure must be selected, and the 
actual specifications of the glazing must be entered into the user input fields for the measure regardless of 
whether there is an improvement in glazing specifications or not. 

 

Results Bar 
The Results Bar in the EDGE App is a summary of the Key Performance Indicators (KPIs) calculated by EDGE. To 
calculate performance against these indicators, EDGE makes assumptions on how the building will be used by 
the occupants. Since the actual usage patterns may differ depending on occupant consumption, the water and 
energy usage and subsequent costs may vary from EDGE predictions. The KPIs include: 

▪ Final Energy Use – the energy consumption (in kWh/year) for the project is calculated automatically by 
EDGE, based on the data entered in the Design section and any reduction achieved through the 
selection of efficiency measures. The results exclude all virtual energy. 

▪ Final Water Use – the water consumption (in m3/year) for the project is calculated automatically by 
EDGE, based on the data entered in the Design section and any reduction achieved through the 
selection of water efficiency measures. 

▪ Final Operational CO2 Emissions – the CO2 emissions (in t CO2/year) based on the final energy use 
multiplied by the CO2 emission factor for the generation of grid electricity and other fuels in the project. 
The default value for the selected country’s CO2 emissions is shown in the Design section but can be 
overwritten if evidence can be provided to support it. The evidence must be from a reliable source such 
as a peer-reviewed publication from an international organization or a specialized government-
approved study. The results exclude all virtual energy. 

▪ Final Embodied Carbon – the embodied carbon (in tCO2e/m2) from the building dimensions and the 
materials selected in the Materials section.  

▪ Final Utility Cost – the monthly cost (in USD/year or local currency per year) for energy and water use. 
The results exclude all virtual energy. 

▪ Subproject Floor Area – the calculated GIA for the Subproject multiplied by the Subproject Multiplier. 
▪ Energy Savings. The results include all virtual energy. 
▪ Water Savings. 
▪ Operational CO2 Savings. The results include all virtual energy. 
▪ Embodied Energy Savings. 
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▪ Utility Cost Savings – the annual savings (in USD and local currency in specific countries) in utility bills. 
The results include all virtual energy. 

▪ Base Case EPI (Energy Performance Index) — energy use per unit area. The results include all virtual 
energy. 

▪ Improved Case EPI (Energy Performance Index) — energy use per unit area. The results include all virtual 
energy. 

▪ Total Building Construction. 
▪ Incremental Cost – Additional cost of implementing the selected efficiency measures (in USD or local 

currency in specific countries). Certain building measures may contribute to a lower overall cost 
compared to the baseline. Therefore, negative incremental costs are possible. EDGE cost data is based 
on average global data and is continuously being refined. It is only meant as a guidance tool for 
comparison between measures. If specific local data is available, the use of it in a more specific financial 
model is encouraged for making financial decisions. 

▪ Increase in Cost (%). 
▪ Payback in Years – Number of years to repay the incremental cost compared to the cost savings of 

utilities. The method used is simple payback based on the capital cost of the measure. 
▪ Number of People Impacted. 
▪ Base Case – Refrigerant Global Warming Potential. 
▪ Improved Case – Refrigerant Global Warming Potential. 
▪ Detailed Results for Typologies – Only applicable to Residential typology. It activates when multiple 

typologies are modelled. 

Saving a Project 
Users can save their projects within the EDGE App.  

▪ A user account is required to save a project file, and a user must be logged in to save the project.  
▪ Fields marked with an asterisk* on the Design tab are also required to save the project file.  

EDGE can be accessed via handheld devices such as iPhones, Android and tablets. Project teams should exercise 
caution when accessing saved projects via handheld devices as EDGE automatically saves changes to projects 
every three minutes; this time limit does not apply to certification providers. 

If a user is not active on EDGE for two hours, the system will log the user out. This duration of time for which 
their session stays active while they are away from their computer can be changed by the user in their profile 
settings.  

To create multiple versions of a project with different combinations of measures, it is best to retain your inputs 
by downloading the data into separate PDFs and saving the documents on your computer (File > Download PDF). 
In this way, you maintain one project file for your building within EDGE. 
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Annex 1: Grouping Logic for Residential Units 
In the EDGE App V3, it is possible to group similar typologies of residential units using the “Multiple Typologies” 
functionality, as shown in Figure 15, instead of creating separate subprojects. 

 

Figure 15: Multiple typologies functionality available in EDGE V3. 

Residential units can be classified into a single typology, such as "Type 1", if their actual area is within ±10% of the 
average typology area and they have the same number of occupants and bathrooms. Otherwise, the unit should 
be modeled separately. 

To group units into a typology, the following rules must be followed: 

▪ Use the count-weighted average of the area 
▪ The average unit areas should be rounded to two decimal places to minimize unintended variation. For 

individual unit area values with decimals, round up or down to the nearest single digit after the decimal 
point 

▪ Only to similar units can be grouped, meaning those with the same number of bathrooms and design 
occupants, and high-level characteristics such as being single-story or duplex 

Note: It is possible to group units with different numbers of floors (e.g., single/duplex) in the same typology, if 
they meet the grouping requirements. 

Exception: If a unit type consists of 5 units or fewer and the total area of these units represents less than 10% of 
the project's GIA, it does not need to be modeled separately. Instead, it can be grouped with the most similar unit 
type. 

Example:  Consider a residential tower with 10 floors totaling an area of 2,957m2. The first 8 floors feature 4 
apartments per floor, while the 9th and 10th floors each contain 2 duplex apartments, as shown in Table 5. 

Table 5: Apartment units in a residential tower with 10 floors totaling an area of 2,957m2. 

 

 

 

 

 

 

The 𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝑎𝑣𝑒𝑟𝑎𝑔𝑒 𝑎𝑟𝑒𝑎 (𝑚2) per unit is: 

𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝑎𝑣𝑒𝑟𝑎𝑔𝑒 𝑎𝑟𝑒𝑎 (𝑚2) =  
𝑛1 ∗ 𝐴1 + 𝑛2 ∗ 𝐴2 + 𝑛3 ∗ 𝐴3

𝑛1 + 𝑛2 + 𝑛3
 

Unit Name Units (n) Toilet Occupancy Unit Area (A) 
(m2) 

Unit A 8 2 3 74.00 

Unit B 8 3 4 83.50 

Unit C 8 3 4 94.30 

Unit D 8 2 4 83.50 

Unit E 2 5 5 137.65 
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Or 

𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝑎𝑣𝑒𝑟𝑎𝑔𝑒 𝑎𝑟𝑒𝑎 (𝑚2) =  
8 ∗ 74 + 8 ∗ 83.5 + 8 ∗ 94.3 + 8 ∗ 83.5 + 2 ∗ 137.65

8 + 8 + 8 + 8 + 2
= 87.00

m2

unit
  

The lower bound, i.e. a 10% reduction in the 𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝑎𝑣𝑒𝑟𝑎𝑔𝑒 𝑎𝑟𝑒𝑎 (𝑚2), is:  

Lower bound (m2) =  90% ∗  87.00 =  78.29m²   

The upper bound, i.e. a 10% increase in the 𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝑎𝑣𝑒𝑟𝑎𝑔𝑒 𝑎𝑟𝑒𝑎 (𝑚2), is: 

Upper bound (m2) =  110% ∗  87.00 =  95.69m² 

 

Table 6 shows the final typology grouping. Units B and C can be grouped together because they have a similar 
number of toilets and occupants, and their areas fall within the acceptable range. Although Unit D meets the 
area conditions, it cannot be grouped with Units B and C due to its different number of toilets. 

Units A and E are not similar to Units B, C, and D. However, the exception allows Unit E (which represents less 
than 10% of the total GIA) to be combined with the most similar typology in terms of the number of toilets and 
occupancy. Finally, Unit A must be grouped into its own typology. 

 

Table 6: Final typology grouping using the area lower and upper method with exception. 

 

 

 

 

Unit Name Units (n) Toilet Occupancy Unit Area (A) 
(m2) 

Typology Justification 

Unit A 8 2 3 74.00 1 
Area outside the lower and 
upper bounds. Total area 

higher than 10% of the GIA. 

Unit B 8 3 4 83.50 2 

Similar number of toilets and 
occupants to Unit C. 

Area within the lower and 
upper bounds. 

Unit C 8 3 4 94.30 2 

Similar number of toilets and 
occupants to Unit B. 

Area within the lower and 
upper bounds. 

Unit D 8 2 4 83.50 3 

Not similar by toilets 
number to Unit B and C 

Total area higher than 10% 
of the GIA. 

Unit E 2 5 5 167.65 2 

Total area lower than 10% of 
the GIA. Assigned to the 

most similar typology (Unit B 
and C) by exception. 
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Annex 2: Core & Shell Measures 
Savings from measures Table 7 can be passed onto tenants if a tenant fit-out-guide is provided. Even if the guide 
mandates higher performance standards, savings must be capped to the ones indicated in the table.  

Table 7: Allowable improved values when passed to tenants in Core & Shell projects by category. 

  
Offices Education Healthcare Retail Mixed Use Industrial 

EEM13 
Cooling 
System 
Efficiency 

The minimum efficiency required in ASHRAE 90.1-2016 or local code for a given cooling 
equipment type and capacity 

EEM16 

Space 
Heating 
System 
Efficiency 

The minimum efficiency required in ASHRAE 90.1-2016 or local code for a given heating 
equipment type and capacity 

EEM18 
Domestic Hot 
Water (DHW) 
System 

Base Case 

The min. efficiency 
required in ASHRAE 
90.1-2016 or local 

code for a given hot 
water equipment 
type and capacity 

EEM22 
Efficient 
Lighting for 
Internal Areas 

Up to of 90lm/W Up to of 70lm/W 

WEM01 
Water-
efficient 
Showerheads 

7 L/min or higher 

WEM02 

Water-
efficient 
Faucets for all 
Bathrooms 

5 L/min or higher 

WEM04 

Efficient 
Water Closets 
for All 
Bathrooms 

No less than 5 L/flush or equivalent. 

WEM08 

Water-
efficient 
Faucets for 
Kitchen Sinks 

7 L/min or 
higher 

Up to 8 L/min or higher 

MEM03 Floor Finish Any value specified in the legally binding contract 
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Annex 3: Unfinished/Partially Finished Residential Buildings 
 

The improved case values in Table 8 may apply to residential typologies (Homes & Apartments) provided that a 
user manual is supplied. 

Table 8: Improved case values for unfinished or partially finished projects per measure. 

 
Measure Homes & Apartments 

EEM13 Cooling System Efficiency Base Case  

EEM16 Space Heating System Efficiency Base Case  

EEM18 Domestic Hot Water (DHW) System Base Case 

EEM22 Efficient Lighting for Internal Areas Base Case 

WEM01 Water-efficient Showerheads Improved case inc. penalty factor 

WEM02 Water-efficient Faucets for all Bathrooms Improved case inc. penalty factor 

WEM04 Efficient Water Closets for All Bathrooms Improved case inc. penalty factor 

WEM08 Water-efficient Faucets for Kitchen Sinks Improved case inc. penalty factor 

MEM03 Floor Finish Savings may be claimed 

 

For water efficiency measures (WEM), please consult the Minimum Water Fixtures for Residential Units section 
for information on how to calculate the improved case including the penalty factor. 
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Annex 4: EU Taxonomy Technical Alignment 
This appendix outlines our current understanding of the EU Taxonomy requirements and can serve as a guide for 
achieving technical alignment that meets or exceeds these criteria. 

Project teams aiming to align with the EU Taxonomy may need to fulfill additional requirements, such as extra 
disclosure obligations, optional measures, Primary Energy Demand (PED) targets, and actions beyond the scope 
of the EDGE V3 certification standard. Those seeking to align with these guidelines should always verify 
alignment with the relevant authorities and assume the content of this section as a recommendation. 

Substantial Contribution Technical Alignment 
 

New Construction 

Table 9 shows the proposed substantial contribution technical alignment between EU Taxonomy and EDGE 
requirements for new construction. 

Table 9: Proposed substantial contribution technical alignment between EU taxonomy and EDGE for new construction. 

EU Taxonomy criteria EDGE V3 Requirements 

The Primary Energy Demand (PED), defining the energy 
performance of the building resulting from the 
construction, is at least 10 % lower than the threshold set 
for the nearly zero-energy building (NZEB) requirements in 
national measures implementing Directive 2010/31/EU of 
the European Parliament and of the Council. The energy 
performance is certified using an as-built Energy 
Performance Certificate (EPC). 

Inside the EU: The Primary Energy Demand of 
the EDGE Advanced/Certified subproject must 
be at least 10% lower than the threshold set 
for nearly zero-energy buildings (NZEB).  
Outside the EU: EDGE Advanced certification. 
 
No fossil fuels used on-site for operational 
energy with all necessary infrastructure for full 
future e-mobility. 

For buildings larger than 5,000 m2, upon completion, the 
building resulting from the construction undergoes testing 
for airtightness and thermal integrity, and any deviation in 
the levels of performance set at the design stage or defects 
in the building envelope are disclosed to investors and 
clients. As an alternative, where robust and traceable 
quality control processes are in place during the 
construction process this is acceptable as an alternative to 
thermal integrity testing. 

Both Inside and Outside the EU: 
Measures: 

▪ EEM05 Insulation of Roof,  
▪ EEM08 Insulation of Exterior Walls,  
▪ EEM10 Air Infiltration of Envelope  

 

must be claimed and meet a minimum 
performance threshold. Refer to the Required 
Measures and Thresholds section. 

For buildings larger than 5,000 m2, the lifecycle Global 
Warming Potential of the building resulting from the 
construction has been calculated for each stage in the life 
cycle and is disclosed to investors and clients on demand.  

Both Inside and Outside the EU: 
For buildings larger than 5,000 m2, the lifecycle 
Global Warming Potential of the building 
resulting from the construction has been 
calculated for each stage in the life cycle and is 
disclosed to investors and clients on demand.  
 
Refer to the Disclosure of Life-cycle Global 
Warming Potential (GWP) section below. 
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Renovation of Existing Buildings 

Table 10 shows the proposed substantial contribution technical alignment between EU Taxonomy and EDGE 
requirements for renovation of existing buildings. 

Table 10: Proposed substantial contribution alignment between EU taxonomy and EDGE for renovation of existing buildings. 

EU Taxonomy criteria EDGE V3 Requirements 

The building renovation complies with the 
applicable requirements for major renovations. 
Alternatively, it leads to a reduction of primary 
energy demand (PED) of at least 30% in a period no 
longer than three years. 

Inside the EU: The building renovation results in a 
verified reduction of at least 30% in the primary energy 
demand or operational emissions (measured in kgCO2e) 
for the EDGE Advanced/Certified subproject or 
equivalent3. Outside the EU: EDGE Advanced 
certification or equivalent3. 

 

Acquisition and Ownership of Buildings  

Table 11 shows the proposed technical alignment between EU Taxonomy and EDGE requirements for 
Acquisition and ownership of buildings: 

Table 11: Proposed alignment between EU taxonomy and EDGE for Acquisition and ownership of buildings. 

EU Taxonomy criteria EDGE V3 Requirements 

For buildings built before 31 December 2020, the 
building has at least an Energy Performance 
Certificate (EPC) class A. As an alternative, the 
building is within the top 15% of the national or 
regional building stock expressed as operational 
Primary Energy Demand (PED) and demonstrated 
by adequate evidence, which at least compares the 
performance of the relevant asset to the 
performance of the national or regional stock built 
before 31 December 2020 and at least distinguishes 
be-tween residential and non-residential buildings. 

Inside the EU: The primary energy demand must be at 
least 15% lower than the threshold set for nearly zero-
energy buildings (NZEB). Outside the EU: EDGE 
Advanced certification or equivalent3. 
 
 

For buildings built after 31 December 2020, the 
building meets the criteria specified in Section 7.1 
of the Annex that are relevant at the time of the 
acquisition. (New Buildings Criteria apply) 

Both Inside and Outside the EU: 
New Buildings Criteria apply. 
 
 

Where the building is a large non-residential 
building (with an effective rated output for heating 
systems, systems for combined space heating and 
ventilation, air-conditioning systems or systems for 
combined air conditioning and ventilation of over 
290 kW) it is efficiently operated through energy 
performance monitoring and assessment. 

Both Inside and Outside the EU: 
For non-residential buildings: EEM30 Submeters for 
Heating and/or Cooling Systems and EEM31 Smart 
Meters for Energy is mandatory measures must be 
claimed with minimum performance requirements. 
Refer to the Required Measures and Thresholds section 
below. 
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Do Not Significant Harm (DNSH) Technical Alignment 
For the DNSH - Climate Adaptation category, the IFC’s Building Resilience Index4 is proposed as a compliant 
alternative. The DNSH - Sustainable Use and Protection of Water and Marine Resources category is partially 
addressed with certain water measures needing to meet minimum performance standards. Other DNSH 
categories are not fully assessed by EDGE V3, so it is recommended to seek alternative methods for compliance. 
 

Table 12: DNSH alignment with EDGE V3. 

Category New Construction Renovation of 
Existing Buildings 

Acquisition and 
ownership of 
buildings 

DNSH - Climate adaptation 

Verified Building 
Resilience Index 
(BRI) assessment 
achieving minimum 
B level is proposed. 

Verified Building 
Resilience Index 
(BRI) assessment 
achieving minimum 
B level is proposed. 

Verified Building 
Resilience Index 
(BRI) assessment 
achieving minimum 
B level is proposed. 

DNSH - Sustainable Use and 
Protection of Water and Marine 
Resources 

Certain water 
measures must be 
claimed with 
minimum 
performance 
requirements. Refer 
to the Required 
Measures and 
Thresholds section 
below. 
 
The Impact from the 
construction site is 
not covered. 

Certain water 
measures must be 
claimed with 
minimum 
performance 
requirements. Refer 
to the Required 
Measures and 
Thresholds section 
below. 
 

N/A. 

DNSH - Transition to a Circular 
Economy 

Not Covered. Not Covered. N/A. 

DNSH - Pollution Prevention and 
Control 

Not Covered. Not Covered. N/A. 

DNSH - Protection and Restoration of 
Biodiversity and Ecosystems 

Not Covered. N/A. N/A. 

 
Note that circularity calculations and other DHSH categories will be likely included in future versions of EDGE. 
 
 
 
 
 

 
4 Building Resilience Index: https://www.resilienceindex.org/  

https://www.resilienceindex.org/
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Required Measures and Thresholds 
Table 13 outlines the minimum performance requirements and measures needed for EU Taxonomy Technical 
Alignment, as well as the specific situations in which they apply. 

Table 13: Minimum performance requirements in measures required for EU Taxonomy Technical alignment. 

Measure Applicability Minimum performance 

EEM05 Insulation of Roof New Construction. 0.49 W/m2K. 

EEM08 Insulation of Exterior Walls New Construction. 1.57 W/m2K. 

EEM10 Air Infiltration of Envelope 
New Construction, in buildings larger 
than 5,000m2. 

Base case. 

EEM30 Submeters for Heating and/or 
Cooling Systems 

Acquisition and ownership of 
buildings, non-residential buildings 
with HVAC system over 290 kW. 

The measure must be claimed. 

EEM31 Smart Meters for Energy is 
mandatory 

Acquisition and ownership of 
buildings, non-residential buildings 
with HVAC system over 290 kW. 

The measure must be claimed. 

EEM33 Onsite Renewable Energy New Construction. 

For Homes, and one-story industrial 

buildings: minimum 60 kWh/m2 

building footprint/year. 

For all other building types: 
Minimum 30 kWh/m2 building 
footprint/year. 

WEM01 Water-efficient Showerheads All buildings. 8 L/min. 

WEM02 Water-efficient Faucets for 
all Bathroom 

All buildings. 6 L/min. 

WEM04 Efficient Water Closets for All 
Bathrooms 

All buildings. 
Maximum flush of 6 L/flush and 
maximum average flush volume of 3.5 
L/flush. 

WEM07 Water-efficient Urinal All buildings. 1 liter/flush. 

WEM08 Water-efficient Faucets for 
Kitchen Sinks 

All buildings. 6 L/min. 

 

Disclosure of Life-cycle Global Warming Potential (GWP)  
New Constructions larger than 5,000m² must disclose the life-cycle Global Warming Potential (GWP) resulting 
from their construction. This requirement means that upfront carbon emissions must be calculated for Module 
A (cradle to key) and Module C (end of life) as defined in the RICS Whole Life Carbon Assessment for the Built 
Environment standard. 

EDGE V3 currently calculates emissions from cradle to gate (A1-A3) for selected building elements5, as shown in 
Table 14. Therefore, it is necessary to (1) include calculations for any missing building elements for stages A0 to 
A5 and Module C and (2) for those elements already included in EDGE, add the emissions for stages A0, A4, A5 
and Module C. 

 
5Building Element Categories: https://www.rics.org/content/dam/ricsglobal/documents/standards/Building-element-
categories.xlsx  

https://www.rics.org/content/dam/ricsglobal/documents/standards/Building-element-categories.xlsx
https://www.rics.org/content/dam/ricsglobal/documents/standards/Building-element-categories.xlsx
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Table 14: Alignment between RICS's building element categories and measures in EDGE V3. 

Category Summary of description Relationship with EDGE V3 

0. Treatment, 
demolition and 
facilitating 
works 

Toxic/contaminated material treatment, Demolition 
works, Facilitating works. 

This assembly is not covered in EDGE V3. 

1.1 Foundations 
and piling 

Foundations up to top of lowest floor slabs (including 
insulation and waterproofing) 

 MEM01 Bottom Floor Construction + 
MEM11 Floor insulation 

1.2 Basement 
retaining walls 
and lowest slab 

Entire lowest floor assembly below the underside of 
screed or lowest floor slab. 
Slabs within the basement box.  
Basement retaining walls (inc. vertical retaining structure, 
insulation and waterproofing external to the wall).  

MEM05 Exterior Walls (below grade 
only) + MEM10 Walls insulation (below 
grade only). 

2.1 Frame 
Frame (vertical) - columns/ structural walls & braces 
Frame (Horizontal) - beams, joists & braces. 

This assembly is not covered in EDGE V3. 

2.2 Upper floors 
Upper floor - structural slabs. 
Upper floor - non-structural slabs. 

 MEM02 Intermediate floors. 

2.3 Roof 
Roof - structural slabs 
Roof - non-structural slabs 

MEM04 Roof Construction. 

2.4 Stairs, 
ramps and 
safety guarding 

Stairs flights excluding any final finishes but including any 
fire proofing. 
Ramps lengths excluding any final finishes but including 
any fire proofing.  
Internal and external vertical access ladders for fire 
escape, access or maintenance.  

This assembly is not covered in EDGE V3.  
  

2.5 External 
envelope 

External - opaque envelope, External - full height glazing 
systems, External - roof finishes/coverings, External - 
safety systems. 

MEM05 Exterior Walls (above grade 
only) + MEM10 Walls insulation (above 
grade only) + MEM09 Roof Insulation. 

2.6 Windows 
and external 
doors 

Windows - vertical, Windows - roof or horizontal, external 
doors. 

MEM07 Window Frames + MEM08 
Window Glazing. 

2.7 Internal 
walls 

Internal walls -solid, Internal walls - non-structural glazed 
walls, windows and vision panels, Internal doors. 

MEM06 Interior Walls. 

2.8 Internal 
doors 

Internal doors inc. movable walls, sliding, folding doors, 
fire shutters and doors in glazed screens.  

This assembly is not covered in EDGE V3.  

3.1 Wall 
finishes 

Render/paint, Tiles, framing and fixings, films. This assembly is not covered in EDGE V3. 

3.2 Floor 
finishes 

Carpet/vinyl, Stone tiles, Raised access floor (RAF) 
pedestal/tile. 

 MEM03 Floor Finish. 

3.3 Ceiling 
finishes 

Substrate/paint, Suspended grid (ceiling system). This assembly is not covered in EDGE V3.  

4. FF&E 
Loose furniture and fittings, IT, Specialist FF&E, Kitchen 
equipment, Audio and visual. 

This assembly is not covered in EDGE V3. 

5. Services/MEP 
Heat source, Central cooling systems, ductwork, electrical 
installation, lighting fittings, communications, water and 
disposal, On site renewable energy generation. 

This assembly is not covered in EDGE V3. 

7. Works to 
existing 
buildings 

Alterations, Repairs to existing buildings. This assembly is not covered in EDGE V3.  
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8. Hard 
landscaping 

Asphalt, Concrete and stone paving, Timber decking, etc. This assembly is not covered in EDGE V3.   

 

Primary Energy Demand (PED) for Selected End Uses 
For all cases, the EU Taxonomy mandates reporting the primary energy demand for specific end uses, including 
heating, cooling, ventilation, domestic hot water, built-in lighting, and auxiliary energy. Therefore, project teams 
should exclude any end uses not listed above. 

Next, the delivered energy for each fuel type must be converted to primary energy demand (PED). This 
conversion should focus solely on the specified end uses. The spreadsheet linked below can assist in calculating 
PED from EDGE outputs: https://epb.center/support/documents/spreadsheet-exported-energy-explained/ 

If the relevant EU country or government authority has not specified primary energy weighting factors for the 
building's location, the factors from Appendix B in ISO 52000-1:2017 can be used, see Table 15. 

Table 15: Weighting factors (based on gross or net calorific value). From ISO 52000-1:2017, Appendix B. 

Energy carrier Delivered from distant fPnren fPren fPtot KCO2e 
(g/kW h) 

Fossil fuels 

Solid 1.1 0 1.1 360 

Liquid 1.1 0 1.1 290 

Gaseous 1.1 0 1.1 220 

Electricity 2.3 0.2 2.5 420 

Delivered from nearby     

District heating 1.3 0 1.3 260 

District cooling 1.3 0 1.3 260 

Delivered from on-site     

Solar 
PV electricity 0 1 1 0 

Thermal 0 1 1 0 

Environment 
Geo-, aero-, 
hydrothermal 

0 1 1 0 

Exported     

Electricity 

To the grid 2.3 0.2 2.5 420 

To non EPB uses 2.3 0.2 2.5 420 

Similarly, if not specified by the EU country or government authority, the following kexp factors, obtained from 
Appendix B in ISO 52000-1:2017, may be used. 

Table 16: kexp-factor. 

Description Value 

k exp that is used to control which part of the exported energy is included in 
the energy performance of the building 

1 
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Annex 5: Portfolio Clustering Workflow 
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